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	CREDITS

	UNIT STANDARD 117924:
Use a Graphical User Interface (GUI)-based word processor to format documents 

	SPECIFIC OUTCOME 1 

Work with multiple documents within a word processing application. 


	ASSESSMENT CRITERION 1 

A number of documents are opened, in order to switch control between them. 

ASSESSMENT CRITERION 2 

Documents are sized so that at least two documents can be seen at the same time. 

ASSESSMENT CRITERION 3 

Text is manipulated between active documents. 


	 2
	5

	SPECIFIC OUTCOME 2 

Format Text using a word processing application. 


	ASSESSMENT CRITERION 1 

A border is applied to text and removed from text to enhance the look-and-feel of a document. 

ASSESSMENT CRITERION 2 

Shading is applied to text and removed from text. 

ASSESSMENT CRITERION RANGE 

Shading is also refers to a filling.
 

ASSESSMENT CRITERION 3 

The current date and time is added. 

ASSESSMENT CRITERION 4 

The use of an automatic field added capability of the word processor is demonstrated, in terms of its purpose and use to speed up typing of words and sentences. 


	
	

	SPECIFIC OUTCOME 3 

Format paragraphs. 


	ASSESSMENT CRITERION 1 

Tabs are set, reset and removed from an existing word processing document. 

ASSESSMENT CRITERION RANGE 

Tabs: left tab, right tab, centre tab, decimal align tab, leading character tab; at least 2 methods of setting tabs are demonstrated.
 

ASSESSMENT CRITERION 2 

The default tab setting is changed in an existing word processing document. 

ASSESSMENT CRITERION 3 

Bullets are applied to and removed from an existing word processing document. 

ASSESSMENT CRITERION RANGE 

Automatic while entering, to existing text.
 

ASSESSMENT CRITERION 4 

Bullet formats are changed within an existing word processing document. 

ASSESSMENT CRITERION RANGE 

Bullet character, bullet position, text position.
 

ASSESSMENT CRITERION 5 

The difference between numbered text and outline numbered text is explained in terms of their use in an existing word processing document. 

ASSESSMENT CRITERION 6 

Numbering is applied to and removed from selected text in an existing word processing document. 

ASSESSMENT CRITERION RANGE 

Automatic while entering, to existing text; single level numbering, multi-level numbering to at least three levels.
 

ASSESSMENT CRITERION 7 

Numbering formats are changed within existing paragraph. 

ASSESSMENT CRITERION RANGE 

Number format, number style, number position, text position.
 

ASSESSMENT CRITERION 8 

A border is applied to and removed from an existing word processing document. 

ASSESSMENT CRITERION 9 

Paragraph spacing is changed in an existing word processing document. 


	
	

	SPECIFIC OUTCOME 4 

Format Pages within an existing word processing document. 


	ASSESSMENT CRITERION 1 

The page format of a document is changed according to given specifications. 

ASSESSMENT CRITERION RANGE 

Page size, page orientation, margins, and layout.
 

ASSESSMENT CRITERION 2 

Manual Page breaks are inserted into an existing word processing document. 

ASSESSMENT CRITERION 3 

Page breaks are deleted from an existing word processing document. 

ASSESSMENT CRITERION 4 

A border is applied to and removed from an existing word processing document. 


	
	

	SPECIFIC OUTCOME 5 

Format an existing word processing Document.


	ASSESSMENT CRITERION 1 

Methods of automatically formatting a document are explained. 

ASSESSMENT CRITERION RANGE 

Templates, styles, manual.
 

ASSESSMENT CRITERION 2 

A header is added to and removed from a document. 

ASSESSMENT CRITERION 3 

A footer is added to and removed from a document. 

ASSESSMENT CRITERION 4 

Page numbers are added to a document. 

ASSESSMENT CRITERION 5 

A document is split into sections according to given specifications. 

ASSESSMENT CRITERION RANGE 

Minimum 2 sections.
 

ASSESSMENT CRITERION 6 

Endnotes and footnotes are inserted into a document. 

ASSESSMENT CRITERION 7 

A Section Break is inserted into and deleted from an existing word processing document. 


	
	

	SPECIFIC OUTCOME 6 

Templates are used and created to facilitate ease of use in future, by having default options when starting a new word processing document. 


	ASSESSMENT CRITERION 1 

A document is created using an existing template. 

ASSESSMENT CRITERION 2 

A document is saved as a new template with a specific name and in a specific folder. 

ASSESSMENT CRITERION 3 

A created template is used to have pre-defined default options when starting a new word processing document. 

ASSESSMENT CRITERION RANGE 

Default options include but is not limited to: 


  Document type, document format depending on type chosen.
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Introduction to Microsoft Word 2010
MS Word 2010 is the word processing software in the Microsoft 2010 Office Suite. It allows you to easily create a variety of professional-looking documents using features such as themes, styles, Smart Art, and more.
Lesson 1 - Setting Up and starting Ms Word 2010 
Assuming you have Microsoft Office 2010 installed in your PC, to start word application, follow the following steps at your PC:

Step (1): Click Start button.
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Step (2): Click All Programs option from the menu.
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Step (3): Search for Microsoft Office from the sub menu and click it.
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Step (4): Search for Microsoft Word 2010 from the submenu and click it.
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This will launch Microsoft Word 2010 application and you will see the following word window.

[image: image5.jpg]



Explore Window - Microsoft Word 2010

Following is the basic window which you get when you start word application. Let us understand various important parts of this window.
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File Tab:
The File tab replaces the Office button from Word 2007. You can click it to check Backstage view, which is the place to come when you need to open or save files, create new documents, print a document, and do other file-related operations.

Quick Access Toolbar:
This you will find just above the File tab and its purpose is to provide a convenient resting place for the Word most frequently used commands. You can customize this toolbar based on your comfort.

Ribbon:
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Ribbon contains commands organized in three components:

· Tabs: They appear across the top of the Ribbon and contain groups of related commands. Home, Insert, Page Layout are example of ribbon tabs.

· Groups: They organize related commands; each group name appears below the group on the Ribbon. For example group of commands related to fonts or or group of commands related to alignment etc.

· Commands: Commands appear within each group as mentioned above.

Title bar:
This lies in the middle and at the top or the window. Title bar shows the program and document titles.

Rulers:
Word has two rulers - a horizontal ruler and a vertical ruler. The horizontal ruler appears just beneath the Ribbon and is used to set margins and tab stops. The vertical ruler appears on the left edge of the Word window and is used to gauge the vertical position of elements on the page.

Help:
The Help Icon can be used to get word related help anytime you like. This provides nice tutorial on various subjects related to word.

Zoom Control:
Zoom control lets you zoom in for a closer look at your text. The zoom control consists of a slider that you can slide left or right to zoom in or out, . and + buttons you can click to increase or decrease the zoom factor.

View Buttons:
The group of five buttons located to the left of the Zoom control, near the bottom of the screen, lets you switch among Word's various document views.

· Print Layout view: This displays pages exactly as they will appear when printed.

· Full Screen Reading view: This gives a full screen look of the document.

· Web Layout view: This shows how a document appears when viewed by a Web browser, such as Internet Explorer.

· Outline view: This lets you work with outlines established using Word.s standard heading styles.

· Draft view: This formats text as it appears on the printed page with a few exceptions. For example, headers and footers aren't shown. Most people prefer this mode.

Document Area:
The area where you type. The flashing vertical bar is called the insertion point and it represents the location where text will appear when you type.

Status Bar:
This displays document information as well as the insertion point location. From left to right, this bar contains the total number of pages and words in the document, language etc.

You can configure the status bar by right-clicking anywhere on it and by selecting or deselecting options from the provided list.

Dialog Box Launcher:
This appears as very small arrow in the lower-right corner of many groups on the Ribbon. Clicking this button opens a dialog box or task pane that provides more options about the group.
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Before you begin creating documents in Word, you may want to set up your Word environment and become familiar with a few key tasks such as how to minimize and maximize the Ribbon, configure the Quick Access toolbar, display the ruler, and use the Word Count and Zoom tools. Unlike Word 2010, commands such as Open and Print are housed in Backstage view, which replaces the Microsoft Office Button.
The Ribbon contains all of the commands you'll need in order to do common tasks. It contains multiple tabs, each with several groups of commands, and you can add your own tabs that contain your favorite commands. Some groups have an arrow in the bottom-right corner that you can click to see even more commands.
To Minimize and Maximize the Ribbon:

The Ribbon is designed to be responsive to your current task and easy to use; however, you can choose to minimize it if it's taking up too much screen space.
1. Click the arrow in the upper-right corner of the Ribbon to minimize it.
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2. To maximize the Ribbon, click the arrow again.

When the Ribbon is minimized, you can make it reappear by clicking on a tab. However, the Ribbon will disappear again when you're not using it.

The Quick Access Toolbar:

The Quick Access Toolbar is located above the Ribbon, and it lets you access common commands no matter which tab you're on. By default, it shows the Save, Undo, and Repeat commands. You can add other commands to make it more convenient for you.
To Add Commands to the Quick Access Toolbar:
1. Click the drop-down arrow to the right of the Quick Access Toolbar.

2. Select the command you wish to add from the drop-down menu. It will appear in the Quick Access toolbar.
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To Display or Hide the Ruler:
The Ruler is located at the top and to the left of your document. It makes it easier to adjust your document with precision. If you want, you can hide the Ruler to free up more screen space.

To Hide or View the Ruler:

1. Click the View Ruler icon over the scrollbar to hide the ruler.

2. To show the ruler, click the View Ruler icon again.
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Entering text

Let us see how easy is to enter text in a word document. Hope you are aware that when you start a word, it displays a new document by default as shown below:
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Document area is the area where where you type your text. The flashing vertical bar is called the insertion point and it represents the location where text will appear when you type.

So just keep your mouse cursor at the text insertion point and start typing whatever text you would like to type. I typed only two word "Hello Word" as shown below. The text appears to the left of the insertion point as you type:
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There are following two important points which would help you while typing:

· You do not need to press Enter to start a new line, as the insertion point reaches the end of the line, Word automatically starts a new one. You would need to press enter if you want to have a new paragraph.

· When you want to add more than one space between words, use the Tab key instead of the spacebar. This way you can properly align text when you use proportional fonts.

Moving around a document 

Word provides a number of ways to move around a document using the mouse and the keyboard.

First let us create some sample text before we proceed. To create a sample text there is a short cut available. Open a new document and type =rand () and just press enter to see the magic. Word will create following content for you:
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Moving with Mouse:
You can easily move the insertion point by clicking in your text anywhere on the screen. Sometime if document is big then you cannot see a place where you want to move. In such situation you would have to use the scroll bars, as shown in the following screen shot:
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You can scroll your document by rolling your mouse wheel, which is equivalent to clicking the up-arrow or down-arrow buttons in the scroll bar.

Moving with Scroll Bars:
As shown in the above screen capture, there are two scroll bars: one for moving vertically within the document, and one for moving horizontally. Using the vertical scroll bar, you may:

· Move upward by one line by clicking the upward-pointing scroll arrow.

· Move downward by one line by clicking the downward-pointing scroll arrow.

· Move one next page, using next page button (footnote).

· Move one previous page, using previous page button (footnote).

· Use Browse Object button to move through the document, going from one chosen object to the next.

Moving with Keyboard:
The following keyboard commands, used for moving around your document, also move the insertion point:

	Keystroke
	Where the Insertion Point Moves
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	Forward one character
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	Back one character
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	Up one line
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	Down one line

	PageUp
	To the previous screen

	PageDown
	To the next screen

	Home
	To the beginning of the current line

	End
	To the end of the current line


You can move word by word or paragraph by paragraph. You would have to hold down the Ctrl key while pressing an arrow key, which moves the insertion point as described here:

	Key Combination
	Where the Insertion Point Moves

	Ctrl + [image: image20.jpg]



	To the next word

	Ctrl + [image: image21.jpg]



	To the previous word

	Ctrl + [image: image22.jpg]



	To the start of the previous paragraph

	Ctrl + [image: image23.jpg]



	To the start of the next paragraph

	Ctrl + PageUp
	To the previous browse object

	Ctrl + PageDown
	To the next browse object

	Ctrl + Home
	To the beginning of the document

	Ctrl + End
	To the end of the document

	Shift + F5
	To the last place you changed in your document.


Moving with Go To Command:
Press F5 key to use Go To command, which will display a dialogue box where you will have various options to reach to a particular page.

Normally we use page number or line number or section number to go directly on a particular page and finally press Go To button.
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Activity 1
· Open Word 2010 on your computer. A new blank document will appear on the screen.

· Make sure your Ribbon is maximized. 

· Display the Ruler.

· Add any commands you wish to the Quick Access toolbar.
· View two documents at the same time
· Close Word without saving the document.
Lesson 2 - Text Basics
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It is important to know how to perform basic tasks with text when working in a word processing application. In this lesson you will learn the basics of working with text including how to insert, delete, select, copy, paste, drag and drop text. 

Working with Text

To Insert Text:

· Move your mouse to the location you wish text to appear in the document.

· Click the mouse. The insertion point appears

· Type the text you wish to appear
To Delete Text:

· Place the insertion point next to the text you wish to delete.

· Press the Backspace key on your keyboard to delete text to the left of the insertion point.

· Press the Delete key on your keyboard to delete text to the right of the insertion point.

To Select Text:

· Place the insertion point next to the text you wish to select. 

· Left-click your mouse and while holding it down, drag your mouse over the text to select it. 

· Release the mouse button. You have selected the text. A highlighted box will appear over the selected text.

When you select text or images in Word, a hover toolbar with formatting options appears. This makes formatting commands easily accessible, which may save you time.

To Copy and Paste Text:

1. Select the text you wish to copy.

2. Click the Copy command on the Home tab. You can also right-click your document and select Copy.
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3. Place your insertion point where you wish the text to appear.

4. Click the Paste command on the Home tab. The text will appear.

To Cut and Paste Text:
1. Select the text you wish to copy.

2. Click the Cut command on the Home tab. You can also right-click your document and select Cut.
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3. Place your insertion point where you wish the text to appear.

4. Click the Paste command on the Home tab. The text will appear.

To Drag and Drop Text:

1. Select the text you wish to copy.
2. Click and drag the text to the location you wish it to appear. The cursor will have a rectangle under it to indicate that you are moving text
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3. Release the mouse button and the text will appear. 

If text does not appear in the exact location you wish, you can click the Enter key on your keyboard to move the text to a new line.

Activity 2
Use the Cover Letter or any other Word document you choose to complete this challenge.
· Open an existing Word document.
· Select a sentence.

· Copy and paste the sentence from one location in the document to another.

· Select another sentence.

· Drag and drop it to another location in the document.

· Select the entire document.

· Change the font style, size, and colour.
Lesson 3 - Saving Documents
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It is important to know how to save the documents you are working with. There are many ways you share and receive documents, which will affect how you need to save the file. 
Are you downloading the document? Saving it for the first time? Saving it as another name? Sharing it with someone that does not have Word 2010? All of these things will affect how you save your Word documents. In this lesson you will learn how to use the save and save as commands, how to save as Word 97-2003 compatible document, and how to save as a PDF.

How to Save Documents
To Use the Save As Command:

1. Click the File tab.

2. Select Save As.
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3. The Save As dialog box will appear. Select the location where you wish to save the document.

4. Enter a name for the document and click Save.
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To Use the Save Command:

1. Click the Save command on the Quick Access Toolbar.
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2. The document will be saved in its current location with the same file name.

If you are saving for the first time and select Save, the Save As dialog box will appear.

To Use the Save As Word 97 - 2003 Document:

1. Click the File tab.

2. Select Save As.

3. In the Save as type drop-down menu, select Word 97-2003 Document.
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4. Select the location you wish to save the document.
5. Enter a name for the document and click Save

To Save As a PDF:

1. Click the File tab.

2. Select Save As.

3. In the Save as type drop-down menu, select PDF.
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4. Select the location you wish to save the document.

5. Enter a name for the document.

6. Click the Save button.

Activity 3
Use the Cover Letter or any other Word document you choose to complete this challenge.
· Open an existing Word document.

· Save the document with the file name trial.

· Save the same document as a PDF file.

· Close the document.

· Open another existing Word document.

· Save the document so that it is compatible with Word 2003.

· Close the document.

Lesson 4 - Creating a New Document
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Word 2010 is a word processor that allows you to create various types of documents such as letters, papers, flyers, faxes and more. In this lesson, you will be introduced to the Ribbon and the new Backstage view, and you will learn how to create new documents and open existing ones.


New Documents
To Create a New, Blank Document:

1. Click the File tab. This takes you to Backstage view.

2. Select New.

3. Select Blank document under Available Templates. It will be highlighted by default.
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4. Click Create. A new, blank document appears in the Word window.

To save time, you can create your document from a template, which you can select from the New Document pane. You can also access templates that are installed on your computer or on Office Online. Click the Microsoft Office Button and select New. You can create blank documents and access templates from the dialog box that appears.

Working with more than one document
Microsoft word allows one to view two or multiple documents simultaneously making it easy for those who work with more than one document at the same time.

A. viewing two documents side-by-side

First open at least two or more Microsoft Office documents, then go to the View tab, and do one of the following:

1. Click Arrange All to tile all documents side-by-side to review their content. 
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2. Clicking View Side by Side will allow you to compare two documents at once. If you have more than two documents open, you will be asked to choose the other document that you want to compare with. Also Synchronous Scrolling will be enabled as well to scroll both documents at the same time to better analyze the content of the document.
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3. Clicking Split will allow you to split a single document into two scrollable sections, so you can review different parts of the same document.
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B. Viewing multiple documents simultaneously 

 It’s not a question of whether Word can work on more than one document at a time. No, it’s a question of how you open those documents:

· The Open command: Just keep using the Open command to open documents. No official limit exists on the number of documents Word can have open, though you may want to avoid having too many open because they slow down your computer.
· The Open dialog box: In the Open dialog box, select multiple documents to open. Press and hold the Ctrl key as you click to select documents. Click the Open button and all the documents open, each in its own window.
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Switching between multiple documents

Each document dwells in its own Word program window. One way to switch between them is to use the Switch Windows menu on the View tab:

1. Click the Switch Windows button on the View tab.

The Switch Windows menu opens, listing as many as nine open documents in Word.

2. To switch to another document, choose it from the menu.

When more than nine documents are open at a time, the last item on the Switch Windows menu is the More Windows command.

3. If it appears, choose the More Windows command to display the Activate dialog box, which lists all open document windows.
4. Select a document from the dialog box and click OK to switch to it.

A quick way to switch from one document window to another is to press the Alt + Tab key combination. Also, each window has its own button on the Windows taskbar. To switch between windows in Word, choose the document name from a button on the taskbar.

Activity 4
· Open Word. A blank document appears in the window.

· Type the sentence, "GCFLearnFree.org is a great, free resource."

· Click the Microsoft Office Button and create a new, blank document.

· Close both Word documents without saving.
· Open multiple documents and view them simultaneously; copy some information from one document and insert in another.
Lesson 5 - Formatting Text
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To create and design effective documents, you need to know how to format text. In addition to making your document more appealing, formatted text can draw the reader's attention to specific parts of the document and help communicate your message.

In this lesson you will learn to format the font size, style, and colour; highlight the text; and use the Bold, Italic, Underline, and Change Case commands.

Format Text

To Format Font Size:

1. Select the text you wish to modify. 
2. Click the drop-down arrow next to the Font Size box on the Home tab. A drop-down menu appears.

3. Move the mouse pointer over the various font sizes. A live preview of the font size will appear in the document.
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4. Select the font size you wish to use. The font size will change in the document.
To Change the Font:

1. Select the text you wish to modify.

2. Click the drop-down arrow next to the Font box on the Home tab. The Font drop-down menu appears.

3. Move the mouse pointer over the various fonts. A live preview of the font will appear in the document.
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4. Select the font you wish to use. The font will change in the document.

To Format Font Colour:

1. Select the text you wish to modify.

2. Click the Font Colour drop-down arrow on the Home tab. The Font Colour menu appears.

3. Move the mouse pointer over the various font colours. A live preview of the colour will appear in the document.
4.  Select the font colour you wish to use. The font colour will change in the document.
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Your colour choices aren't limited to the drop-down menu that appears. Select More Colours at the bottom of the list to access the Colours dialog box. Choose the colour that you want and click OK.
To Highlight Text:

1. From the Home tab, click the Text Highlight Colour drop-down arrow. The Highlight Colour menu appears.
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2. Select the desired highlight colour.

3. Select the text you wish to modify. It will then be highlighted.
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4. To switch back to the normal cursor, click the Text Highlight Colour command.

To Use the Bold, Italic, and Underline Commands:

1. Select the text you wish to modify.

2. Click the Bold (B), Italic (I), or Underline (U) command in the Font group on the Home tab
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To Change the Text Case:

1. Select the text you wish to modify.

2. Click the Change Case command in the Font group on the Home tab.

3. Select the desired case option from the list.
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To Change Text Alignment:

1. Select the text you wish to modify.

2. Select one of the four alignment options from the Paragraph group on the Home tab.

· Align Text Left: Aligns all the selected text to the left margin.

· Center: Aligns text an equal distance from the left and right margins.

· Align Text Right: Aligns all the selected text to the right margin.

· Justify: Justified text is equal on both sides and lines up equally to the right and left margins. Many newspapers and magazines use full-justification.
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Inserting borders in text:
You can add a border to any or all sides of each page in a document, to pages in a section, to the first page only, or to all pages except the first. You can add page borders in many line styles and colours, as well as a variety of graphical borders.
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You can set apart text from the rest of a document by adding borders.
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You can add borders to a table or individual table cell.
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You can add borders to drawing objects and pictures. You can change or format the border of an object in the same way that you change or format a line.

Add borders

Do one of the following:

ADD A BORDER TO A PICTURE, A TABLE, OR TEXT

1. Launch Microsoft Word and open the document of your choice. Click the “Home” tab on the Command Ribbon.

2. Click and drag where you want to insert the border. For example, select a single word or several lines of text.

3. Click the down arrow for the Borders button in the “Paragraph” group. This button has an icon that looks like a grid. A list of border options appears, such as All Borders, Left Border and Outside Borders.

4. Click the Outside Borders option. A border appears around the selected text.

5. Edit the border. Click the border button in the “Paragraph” group. This button displays the last command that you selected.

6. Click the “Borders and Shading” option. A window for “Borders and Shading” appears.

7. Click the preferred border commands, such as "Setting," "Style," "Width" or "Clip Art." The “Preview” box displays the effects.

8. Click “OK.”

ADD PAGE BORDER

1. Open the document to which you would like to add the page border.

2. On the Page Layout tab, click Page Border in the Page Background group.
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3. In the Borders and Shading window, you can customize your border in a number of ways.

4. First, select the border Style.

5. Click the Colour drop-down list to choose the appropriate colour for the border.

6. Select an option from the Width drop-down list. Note: For specific border styles, only certain widths are available.
7. If you wish, select a design from the Art drop-down list.  If you do so, the Style and Colour border settings will not be applied as the Art designs have their own custom settings. You will, however, be able to set the Width.

8. Once you have selected your border options, you can choose from a number of ways to apply the border to your page.

· In the Settings area, select one of the options to see it display in the Preview area

· In the Preview area, click in the diagram where you would like the border to appear

· In the Preview area, click the buttons that reflect the area you would like to apply the border.

1. This border can be applied to a specific area within your document. Select from the Apply to drop-down list to choose which area the border should appear.

1. Once you are happy with your selection displayed in the Preview area, click OK.
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Applying and removing shading from text:
· Select the paragraph text you want to format.

· Click the Home tab.

· Click the Shading button arrow, and then click to select the shading colour you want to apply to the selected text.
Adding date and time:
Word 2010 offers a list of date/time formats, among them you can select any format to show in the document. Furthermore, it offers multiple languages to show the date/time, you can pick out any language in which date/time to be shown.

For inserting date or time in the document, place the insert cursor where you want to insert date or time and under Insert tab, click Date and Time in Text group.
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Now select the Date/time format along with language and click OK.
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Click the Update Automatically option if you want the date-and-time text to always be current.

You can also set selected date/time format as default. Just click Set As Default button to make any specified format default date/time format.
Using the Word Print Date field

The Print Date field reflects the current date (and time, if you like) that a document is printed. Here’s how it’s done:

1. Click the Insert tab.

2. In the Text group, choose Quick Parts→ Field.
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3. The Field dialog box appears.

4. Select Date and Time from the Categories drop-down list.

5. Select Print Date from the Field Names list.

6. In the Field Properties section of the Field dialog box, choose a date-and-time format.

7. Click OK.

 Inserting a date in a header

1. Click the Insert tab. 
2. In the toolbar, click the Header icon, and choose your header type. 
3. Click the Insert tab. 
4. Click Date and Time, choose your Date and Time style, and then click OK.

Automatic field added capability:
Fields are an efficient way to maintain frequently updated information. Whether it is your document filename, the last date your document was saved, the total number of pages, or the initials of the user who created the document, you can insert a field for virtually any kind of information. Word will then automatically update the information in your fields as changes occur within the document. You can insert fields into a header or footer or anywhere else in your document.
Insert a field

1. Click where you want to insert a field.

2. On the Insert tab, in the Text group, click Quick Parts, and then click Field.
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3. In the Categories list, select a category.

4. In the Field names list, select a field name.

5. Select any properties or options that you want.

A. Inserting the File Name Field

You can create a field that will insert the document's name and location.

1. Place the insertion point where you want the field to appear
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2. From the Ribbon, select the Insert tab

3. In the Text group, click QUICK PARTS» select Field... The Field dialog box appears.
4. From the Categories pull-down list, select Document Information
5. From the Field names scroll box, select File Name
6. OPTIONAL: To include the path (location) of the file in the filename field, from the Field options section, select Add Path to Filename
7. To close the Field dialog box, click OK
B. Inserting the Save Date Field

You can create a field that will insert the date and time the document was last saved. The Date field inserts the current date.

When you click Date and Time in the Text group on the Insert tab, Word inserts a Date field.

You can also insert a Date field in the body of a document by doing the following:

1. On the Insert tab, in the Text group, click Quick Parts, and then click Field.

2. In the Field dialog box, under Field names, click Date.
3. From the Categories pull-down list, select Date and Time
4. From the Field names scroll box, select Save Date
5. Under Field properties, select the desired format
6. To close the Field dialog box, click OK
Activity 5
· Create a new, blank Word document.

· Insert text into the document.

· Change the font size of some text.

· Change the font style of some text.

· Change the font colour of some text.

· Add and remove text shading
· Add and remove borders
· Use automatic field added capability
· Save the document if you wish.
Lesson 6 - Using a Template
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A template is a pre-designed document that you can use to create documents quickly without having to think about formatting. With a template, many of the big document design decisions such as margin size, font style and size, and spacing are predetermined.

 In this lesson, you will learn how to create a new document with a template and insert text into it.

Create a New Document with a Template
To Insert a Template:

1. Click the Microsoft Office Button Click the File tab to go to Backstage view.

2. Select New. The New Document pane appears.

3. Click Sample templates to choose a built-in template, or select an Office.com template category to download a template.

[image: image60.png]e
Bsers
2 Open Choose a Sample
o cose template or an FD
. Office.com template |
Recent Bank oy Newfrom
document tempines cisting
. e
print
save &usend
Help
2 optons





4. Select the desired template and click Create. A new document will appear using the template you have selected.
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You can select any of the categories in the Microsoft Office Online section of the New Document Dialog box. This will display templates that are available online free of charge. Your computer must have Internet access to download these templates.

Information about Using Templates

Templates include placeholder text that is surrounded by brackets. Often, this placeholder text includes information regarding the content for a specific area. 
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Additionally, some information is prefilled in the template. You can modify your Word Options and change the prefilled information that appears. Some templates simply use regular text as the placeholder text, rather than the "traditional" placeholder text with brackets. In those cases, just delete the text and type in your own text.
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Word templates may include separate Quick Parts sections that give you various options for the template.

[image: image64.png]»[Type your name]

»[Type your name]





To Insert Text into a Template:

1. Click on the text you want to replace. The text will appear highlighted and a template tag will appear.
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2. Enter some text. It will replace the placeholder text.

For some fields, there is a drop-down arrow that you can use to select the information, rather than typing it. For example, a date field will show a calendar so that you can choose the date more easily.
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To Change Prefilled Information:

 In some templates, your name or initials will be automatically added. This is known as prefilled information. If your name or initials are incorrect, you will need to change them in Word Options.

1. Click the File tab to go to Backstage view.

2. Click the Options button. The Word Options dialog box appears.

3. Enter the user name and/or initials in the General section, then click OK.
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If you are using a public computer, such as one at a library, you may not want to change these settings.

You can start with a blank document and save it as a template, or you can create a template that is based on an existing document or template.

Saving a template

1. Click the File tab, and then click New. 
2. Under Available templates, click New from existing.

3. Click Blank document, and then click Create.

4. Make the changes that you want to the margin settings, page size and orientation, styles, and other formats.

You can also add content controls such as a date picker, instructional text, and graphics that you want to appear in all new documents that you base on the template.

5. Click the File tab, and then click Save As.
6. In the Save As dialog box, do one of the following:

· On a computer that is running Windows 7, scroll to the top of the folder list, and under Microsoft Word click Templates.

· On a computer that is running Windows Vista, under Favorite Links, click Templates.

· On a computer that is running Windows XP, under Save in, click Trusted Templates.

7. Give the new template a file name, select Word Template in the Save as type list, and then click Save.

 NOTE   You can also save the template as a Word Macro-Enabled Template (.dotm file) or a Word 97-2003 Template (.dot file).
8. Close the template.

Activity 6
· Create a new document using a template. 


· Enter text into the template.

· Modify the user name and initials for your version of Word if you are using a home computer. 
Note: If you are using a public computer such as one at a library, you do not need to change these settings.

· Save the document.

Lesson 7 - Working with Lists
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Bulleted and numbered lists can be used in your documents to format, arrange and emphasize text. In this lesson, you will learn how to modify existing bullets, insert new bulleted and numbered lists, select symbols as bullets, and format multilevel lists.

Bulleted and Numbered Lists
To Create a List:

1. Select the text that you want to format as a list.

2. Click the Bullets or Numbering drop-down arrow on the Home tab.
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3. Select the bullet or numbering style you would like to use, and it will appear in the document.

4. To remove numbers or bullets from a list, select the list and click the Bullets or Numbering commands.

To Select an Alternate Bullet or Numbering Style:

· Select all of the text in an existing list.

· Click the Bullets or Numbering commands on the Home tab.

· Left-click to select an alternate bullet or numbering style.

The difference between numbered text and outline numbered text in terms of their use: 

· Numbered text: It could be a list of text that has a number in front of it. 

· Outline numbered text: An outline numbered list shows list items at different levels rather than indented at one level.
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Bulleted Lists

To Use a Symbol as a Bullet:

1. Select an existing list.

2. Click the Bullets drop-down arrow
3. Select Define New Bullet from the list. The Define New Bullet dialog box appears.

4. Click the Symbol button. The Symbol dialog box appears.
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5. Click the Font drop-down box and select a font. The Wingdings and Symbol fonts are good choices as they have a large number of useful symbols.
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6. Select the desired symbol.
7. Click OK. The symbol will now appear in the Preview section of the Define New Bullet dialog box.
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8. Click OK to apply the symbol to the list in the document.

To Change the Bullet Colour:

1. Select an existing list.

2. Click the Bullets drop-down arrow.

3. Select Define New Bullet from the list. The Define New Bullet dialog box appears.

4. Click the Font button. The Font dialog box appears.

5. Click the Font Colour drop-down box.
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6. Click on the desired colour to select it.
7. Click OK. The bullet colour will now appear in the Preview section of the Define New Bullet dialog box.
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8. Click OK to apply the bullet colour to the list in the document.

You can also change the bullet font and formatting in the Font dialog box.
Multilevel Lists:
Multilevel lists allow you to create an outline with multiple levels. In fact, you can turn any bulleted or numbered list into a multilevel list by simply placing the insertion point at the beginning of a line and pressing the Tab key to change the level for that line. You can then use the Multilevel List command to choose the types of bullets or numbering that are used.
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To Create a Multilevel List:

1. Select the text that you want to format as a multilevel list.

2. Click the Multilevel List command on the Home tab.
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3. Click the bullet or numbering style you would like to use. It will appear in the document.

4. Position your cursor at the end of a list item and press the Enter key to add an item to the list.

To remove numbers or bullets from a list, select the list and click the Bullets or Numbering commands.

To Change the Level of a Line:

1. Place the insertion point at the beginning of the line.
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2. Press the Tab key to increase the level.
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3. Hold Shift and press Tab to decrease the level.

Activity 7
Use the Resume or any Word template you choose to complete this challenge.
· Change the bullet of an existing list to a different bullet.

· Insert a new numbered list into the document.
· Explain the difference between numbered text and outlined numbered text
· Modify the colour of a bullet.

Lesson 8 - Line and Paragraph Spacing
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An important part of creating effective documents lies in the document design. As part of designing the document and making formatting decisions, you will need to know how to modify the spacing. In this lesson, you will learn how to modify the line and paragraph spacing in various ways.
Line spacing can either be measured in lines or points. For example, when text is double-spaced, the line spacing is two lines high. On the other hand, you might set 12-point text with something like 15-point spacing, which gives enough height for the text plus a little extra space. You can reduce the line spacing to fit more lines on the page, or you can increase it to improve readability.
Modifying Spacing
To Format Line Spacing:

1. Select the text you want to format.

2. Click the Line and Paragraph Spacing command in the Paragraph group on the Home tab.

3. Select the desired spacing option from the drop-down menu.
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4. From the drop-down menu, you can also select Line Spacing Options to open the Paragraph dialog box. From here, you can adjust the line spacing with even more precision.
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5. Modify the before and after points to adjust line spacing, as needed.
6. Click OK.

If you select At least or Exactly in the Paragraph dialog box, the line spacing will be measured in points. Otherwise, it will be measured in lines.

Just as you can format spacing between lines in your document, you can also choose spacing options between each paragraph. Typically, extra spaces are added between paragraphs, headings, or subheadings. Extra spacing between paragraphs adds emphasis and makes a document easier to read. 

To Format Paragraph Spacing:
1. Click the Line and Paragraph Spacing command on the Home tab.
2. Select Add Space Before Paragraph or Remove Space After Paragraph from the drop-down menu.

3. From the drop-down menu, you can also select Line Spacing Options to open the Paragraph dialog box. From here, you can control exactly how much space there is before and after the paragraph.
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4. Click OK.

Line spacing is measured in lines or points, which is referred to as leading. When you reduce the leading, you automatically bring the lines of text closer together. Increasing the leading will space the lines out, allowing for improved readability. 

Activity 8
Use the Resume or any Word template you choose to complete this challenge.
· Change the line spacing of a list.

· Change the line spacing of a paragraph of text.

· Change the paragraph spacing between body text and a heading.

Lesson 8 - Modifying Page Layout 
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You may find that the default page layout settings in Word are not sufficient for the document you wish to create, in which case you will want to modify those settings. In addition, you may want to change the page formatting depending on the document you are creating. In this lesson, you will learn how to change the page orientation, paper size, and page margins, and insert a break.

Page Layout and Formatting

To Change Page Orientation:

1. Select the Page Layout tab.

2. Click the Orientation command in the Page Setup group.
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3. Click either Portrait or Landscape to change the page orientation.

Landscape format means that the page is oriented horizontally, and portrait format is oriented vertically.

To Change the Paper Size:

1. Select the Page Layout tab.

2. Click the Size command and a drop-down menu will appear. The current page size is highlighted.
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3. Click the size option you desire. The page size of the document changes.

To Format Page Margins:

1. Select the Page Layout tab.

2. Click the Margins command. A menu of options appears. Normal is selected by default.

3. Click the predefined margin size you desire.
[image: image87.png]Insert | Pagelayout | References

B 0 E 5

Orientation Size Columns

5 S i

Hyphen

Last Custom Setting

Top: 1 Bottom: 0.5
Lt 1 Right: 1 |
Normal

Top: 1 Bottom: 1

Lt 1 Right: 1

Moderate
Top: 1 Bottom: 1
Left 075 Right 075
Wide

Top: 1 Bottom: 1
Lt 2 Right. 2
Mirrored

Top: 1 Bottom: 1
Inside: 125" Outside:]

Office 2003 Defauit
Top: 1 Bottom: 1
Left 125 Right 125

Custom Margins.

I




To Use Custom Margins:

1. From the Page Layout tab, click Margins.

2. Select Custom Margins. This will take you to the Page Setup dialog box.

3. Adjust the margin sizes for each side of the page and click OK.
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Automatic hyphenation:
Automatic hyphenation inserts optional hyphens. An optional hyphen is a hyphen that Word uses only when a word or a phrase appears at the end of a line. If the word or phrase moves to a different position because of editing, the optional hyphen is removed. When you use automatic hyphenation, Office Word 2010 automatically inserts hyphens where they are needed. If you later edit the document and change line breaks, Office Word 2010 will rehyphenate the document.

To select automatic hyphenation, follow these steps:

1. Make sure that no text is selected.

2. On the Page Layout tab, in the Page Setup group, click Hyphenation and then choose Automatic:
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You can choose automatic hyphenation in Hyphenation dialog box. On the Page Layout tab, in the Page Setup group, click Hyphenation and choose Hyphenation Options...:
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· For automatic hyphenation select the Automatically hyphenate document check box

· If you do not want to hyphenate words in uppercase letters, leave the Hyphenate Words in CAPS check box blank

· Set a value in the Hyphenation zone
This value is the distance in inches between the end of the last complete word in a line of text and the margin - in other words, the degree of raggedness Word should allow. Word uses this measurement to determine if a word should be hyphenated. Large values decrease the number of hyphens; low values increase the number of hyphens but reduce the raggedness of the right margin.

· If you don't want consecutive lines to have hyphens - it can make a document look a little strange - set a limit in the Limit consecutive hyphens to box.

To Insert a Break:

1. Place the insertion point where you want the break to appear.

2. Select the Page Layout tab.

3. Click the Breaks command. A menu appears.
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4. Click the desired break option to create a break in the document.

Why would you need to use a break? Each type of break serves a different purpose and will affect the document in different ways. Page breaks move text to a new page before reaching the end of a page, while section breaks create a barrier between parts of the document for formatting purposes. Column breaks split text in columns at a specific point. Practice using the various break styles to see how they affect the document. 
Adding section breaks:
You can use section breaks to change the layout or formatting of a page or pages in your document. For example, you can lay out part of a single-column page as two columns. You can separate the chapters in your document so that the page numbering for each chapter begins at 1. You can also create a different header or footer for a section of your document.

The following examples show the types of section breaks that you can insert. (In each illustration, the double dotted line represents a section break.)
To insert a section break, click Page Layout, click Breaks, and then click the section break that you want to add.

[image: image92.png]i preaks +

O & 0 =]
Margins Orientation Size Columns

Page Setup &

Line Humbers +





A Next Page section break starts the new section on the next page
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A Continuous section break starts the new section on the same page.
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A continuous section break is useful when you want to change the formatting, such as changing the number of columns, without starting a new page.

An Even Page or an Odd Page section break starts the new section on the next even-numbered or odd-numbered page.
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When you want document chapters to begin on an odd page, use an Odd page section break.

Activity 9
Use the Newsletter or any Word document you choose to complete this challenge.
· Change the page orientation.

· Change the paper size.

· Modify at least one margin.

· Insert a section break.

Lesson 10 - Working with Headers and Footers
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You can make your document look professional and polished by utilizing the header and footer sections. The header is a section of the document that appears in the top margin, while the footer is a section of the document that appears in the bottom margin. Headers and footers generally contain information such as page number, date, document name, etc. 

In this lesson, you will learn how to insert built-in and blank headers and footers.

Headers and Footers

To Insert a Header or Footer:

1. Select the Insert tab.

2. Click either the Header or Footer command. A drop-down menu will appear.

3. From the drop-down menu, select Blank to insert a blank header or footer, or choose one of the built-in options.
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4. The Design tab will appear on the Ribbon, and the header or footer will appear in the document.

5. Type the desired information into the header or footer.
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6. When you are finished, click Close Header and Footer in the Design tab, or hit the Esc key.

After you close the header or footer, it will still be visible, but it will be locked. To edit it again, just double-click anywhere on the header or footer, and it will become unlocked.
To Insert the Date or Time into a Header or Footer:

1. Double-click anywhere on the header or footer to unlock it. The Design tab will appear.

2. From the Design tab, click the Date and Time command.
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3. Select a date format in the dialog box that appears.
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4. Place a checkmark in the Update Automatically box if you would like it to always reflect the current date. Otherwise, it will not change when the document is opened at a later date.
5. Click OK. The date/time now appears in the document.
To Remove Content Controls:
By default, some of the built-in headers and footers have snippets of text that are called Content Controls. Content Controls can contain information such as the document title or company name, and they allow you to enter that information into a form field.
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However, you will often just want to type a "normal" header, without any Content Controls. To do this, you will need to remove any Content Control fields from the header or footer.

1. With the header or footer section active, right-click the Content Control field you wish to remove. A drop-down menu will appear.

2. Click Remove Content Control. The Content Control field will disappear.
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Other Header and Footer Options

There are many other header and footer options that you can use to design these sections of your document. You can review the Header and Footer Tools Design tab, to view and explore the design options.
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Adding Page Numbers
Word can automatically label each page with a page number and place it in a header, a footer or in the side margin. You can add page numbers to an existing header or footer, or you can insert page numbers into a new header or footer.
To Add Page Numbers to an Existing Header or Footer:

1. Select the header or footer. The Design tab will appear.

2. Place the insertion point where you want the page number to be. You can place it anywhere except inside a Content Control field.
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3. From the Design tab, select the Page Number command.
4. Click Current Position and select the desired style. The page number will appear in the document.
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If you have already typed information into your header or footer, it's important to place the page number at the Current Position to avoid losing anything. If you select a page number from Top of Page or Bottom of Page, it will delete anything that you have already added to the header or footer.

To Insert Page Numbers into a New Header or Footer:

1. From the Insert tab, click Page Number. A drop-down menu will appear.

2. Select the desired page number style, and it will appear in your document.
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To Hide the Page Number on the First Page:

In some documents, you may not want the first page to show the page number. You can hide the first page number without affecting the rest of the pages.
1. Select the header or footer that contains the page number.

2. From the Design tab, place a checkmark next to Different First Page. The header and footer will disappear from the first page. If you want, you can type something new in the header or footer, and it will only affect the first page.
[image: image107.png]Design

Diferent s Page e

[T Different Odd & Even Pages | [ Foot

B e

Show Document Text

Options

Different First Page:

Specify a unique header and footer
for the fist page of the document,

@ Press i for more help.




If you are unable to select Different First Page, it may be because an object within the header or footer is selected. Click in an empty area within the header or footer to make sure nothing is selected.

To Format the Page Numbers:

1. Select the header or footer that contains the page number.

2. From the Design tab, select the Page Number command.

3. Click Format Page Numbers.
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4. From the dialog box, Select the desired Number format.
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5. Next to Start at, enter the number that you want the page numbers to start with.
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If you have created a page number in the side margin, it's still considered part of the header or footer. You won't be able to select the page number unless the header or footer is selected.

Activity 10
Use the Newsletter or any Word document you choose to complete this challenge.
· Add your name in the header of a document.

· Right-align the text in the header.

· Select a built-in footer with page number.
· Remove header and footer 
Lesson 11 - Using Indents and Tabs
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A great way to draw attention to specific text is to indent it. There are several ways in Word that you can indent text; however, it’s important to use these tools appropriately and indent correctly each time. This can save time and make the editing process go smoothly.

In this lesson, you will learn how to use the tab selector and the horizontal ruler to set tabs and indents, and how to use the Increase and Decrease Indent commands. 

Indents and Tabs

In many types of documents, you may wish to indent only the first line of each paragraph. This helps to visually separate paragraphs from one another. It's also possible to indent every line except the first line, which is known as a hanging indent.
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To Indent Using the Tab Key:

A quick way to indent is to use the Tab key. This will create a first line indent of 1/2 inch.

1. Place the insertion point at the very beginning of the paragraph you wish to indent.
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2. Press the Tab key. On the ruler, you should see the First Line Indent marker move to the right by 1/2 inch (1.27 cm)
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If you can't see the ruler, click the View Ruler icon over the scrollbar to display it.
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To Create or Adjust a First Line Indent or Hanging Indent:

1. Place the insertion point anywhere in the paragraph you wish to indent, or select one or more paragraphs.

2. To adjust the first line indent, drag the First Line Indent marker on the ruler.

3. To adjust the hanging indent, drag the Hanging Indent marker.

4. To move both markers at the same time, drag the Left Indent marker. This will indent all of the lines in the paragraph.
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To Use the Indent Commands:

If you want to indent all of the lines in a paragraph, you can use the Indent commands on the Home tab.

1. Select the text you wish to indent.

2. Make sure you are on the Home tab.

3. Click the Increase Indent command to increase the indent by increments of 1/4 inch (0.635 cm)
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4. Click the Decrease Indent command to decrease the indent by increments of 1/2 inch (1.27 cm)
If you would prefer to type in your indent amounts, you can use the Indent fields on the Page Layout tab.
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Tabs
Tabs are often the best way to control exactly where text is placed. By default, every time you press the tab key, the insertion point will move 1/2 inch to the right. By adding tab stops to the Ruler, you can change the size of the tabs, and you can even have more than one type of alignment in a single line. For example, you could Left Align the beginning of the line and Right Align the end of the line by simply adding a Right Tab.
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Pressing the tab key can either add a tab or create a first line indent depending on where the insertion point is. Generally, if the insertion point is at the beginning of an existing paragraph, it will create a first line indent; otherwise, it will create a tab.

The Tab Selector

The tab selector is above the vertical ruler on the left. Hover over the tab selector to see the name of the type of tab stop that is active.
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The types of tab stops include:

· Left Tab[image: image121.png]


: Left-aligns the text at the tab stop.

· Center Tab[image: image122.png]


: Centers the text around the tab stop.

· Right Tab[image: image123.png]


: Right-aligns the text at the tab stop.

· Decimal Tab[image: image124.png]


: Aligns decimal numbers using the decimal point.

· Bar Tab[image: image125.png]


: Draws a vertical line on the document.

· First Line Indent[image: image126.png]


: Inserts the indent marker on the ruler and indents the first line of text in a paragraph.

· Hanging Indent[image: image127.png]


: Inserts the hanging indent marker and indents all lines other than the first line.

Although Bar Tab, First Line Indent, and Hanging Indent appear on the tab selector, they're not technically tabs.

To Add Tab Stops:

1. Select the paragraph or paragraphs that you want to add tab stops to. If you don't select any paragraphs, the tab stops will apply to the current paragraph and any new paragraphs that you type below it.

2. Click the tab selector until the tab stop you wish to use appears.

3. Click the location on the horizontal ruler where you want your text to appear (it helps to click on the bottom edge of the ruler). You can add as many tab stops as you want.

4. Place the insertion point where you want to add the tab, and press the Tab key. The text will jump to the next tab stop.

5. To remove a tab stop, just drag it off of the Ruler.

Click the Show/Hide ¶ command on the Home tab (in the Paragraph group). This will allow you to see the nonprinting characters such as the spacebar, paragraph (¶), and Tab key markings.
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To Use Find and Replace to Replace Existing Text:

Find text

You can quickly search for every occurrence of a specific word or phrase.

1. On the Edit menu, click Find or on the Home tab, in the Editing group, click Find.
2. In the Find what box, enter the text that you want to search for.

3. Select any other options that you want.

To select all instances of a specific word or phrase at once, select the Highlight all items found in check box, and then select which portion of the document you want to search in by clicking in the Highlight all items found in list.
4. Click Find Next or Find All.
To cancel a search in progress, press ESC.


Replace text

You can automatically replace text -for example, you can replace "Color" with "Colour." 
1. On the Edit menu, click Replace.

2. In the Find what box, enter the text that you want to search for.

3. In the Replace with box, enter the replacement text.

4. Select any other options that you want.

5. Click Find Next, Replace, or Replace All.

You can also use the Find command to locate specific information in a document. For example, if you are working with a twenty page report, it would be time consuming to search the document for a specific topic. You can use the Find command to locate all instances of the word or phrase in the document. This is a great way to save time when working with long documents.

Activity 11
Use the Report or any Word document you choose to complete this challenge.
· Practice using the Tab key to indent the first line of a paragraph.

· Select some text and use the Increase and Decrease Indent commands to see how they change the text.

· Explore the tab selector and all the tab stops. Practice using each one.

Lesson 12 - End notes and footnotes
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Footnotes and endnotes are used in printed documents to explain, comment on, or provide references for text in a document. You might use footnotes for detailed comments and endnotes for citation of sources. 
A footnote or an endnote consists of two linked parts-the note reference mark and the corresponding note text.
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1. Footnote and endnote reference marks

2. Separator line

3. Footnote text

4. Endnote text

Insert a footnote or an endnote

Microsoft Word automatically numbers footnotes and endnotes for you. You can use a single numbering scheme throughout a document, or you can use different numbering schemes within each section in a document.

Commands for inserting and editing footnotes and endnotes can be found on the References tab in the Footnotes group.
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1. Insert Footnote

2. Insert Endnote

3. Footnote & Endnote Dialog Box Launcher

When you add, delete, or move notes that are automatically numbered, Word renumbers the footnote and endnote reference marks.

NOTE: If the footnotes in your document are numbered incorrectly, your document may contain tracked changes. Accept the tracked changes so that Word will correctly number the footnotes and endnotes.

1. In Print Layout view, click where you want to insert the note reference mark.

2. On the References tab, in the Footnotes group, click Insert Footnote or Insert Endnote. Word inserts the note reference mark and places the insertion point in the text area of the new footnote or endnote.

By default, Word places footnotes at the end of each page and endnotes at the end of the document.

3. Type the note text.

4. Double-click the footnote or endnote reference mark to return to the reference mark in the document.

5. To change the location or format of footnotes or endnotes, click the Footnote and Endnote Dialog Box Launcher, and do one of the following:

· To convert footnotes to endnotes or endnotes to footnotes, under Location choose either Footnotes or Endnotes and then click Convert. In the Convert Notes dialog box, click OK.

· To change the numbering format, click the desired formatting in the Number format box and click Apply.
· To use a custom mark instead of a traditional number format, click Symbol next to Custom mark, and then choose a mark from the available symbols. This will not change the existing note reference marks. It will only add new ones.

Change the number format of footnotes or endnotes 
1. Place the insertion point in the section in which you want to change the footnote or endnote format. If the document is not divided into sections, place the insertion point anywhere in the document.

2. On the References tab, click the Footnote and Endnote Dialog Box Launcher.

3. Click Footnotes or Endnotes
4. In the Number format box, click the option that you want.

5. Click Apply.

Change the starting value for footnotes or endnotes 
Word will automatically number footnotes beginning with "1" and endnotes beginning with "i", or you can choose a different starting value.

 NOTE   If the footnotes in your document are numbered incorrectly, your document may contain tracked changes. Accept the tracked changes so that Word will correctly number the footnotes and endnotes.

1. On the References tab, in the Footnotes group, click the Footnote & Endnote Dialog Box Launcher.
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2. In the Start at box, choose the desired starting value.

3. Click Apply.

Create a footnote or endnote continuation notice

If a footnote or endnote is too long to fit on a page, you can create a continuation notice to let readers know that a footnote or endnote is continued on the next page.

1. Make sure that you are in Draft view by going to the View tab and clicking Draft.

1. On the References tab, in the Footnotes group, click Show Notes.

2. If your document contains both footnotes and endnotes, a message appears. Click View footnote area or View endnote area, and then click OK.

3. In the note pane list, click Footnote Continuation Notice or Endnote Continuation Notice.

4. In the note pane, type the text that you want to use for the continuation notice.

Change or remove a footnote or endnote separator
Word separates document text from footnotes and endnotes with a short horizontal line called a note separator. If a note overflows onto the next page, Word prints a longer line called a note continuation separator. You can customize separators by adding text or graphics.

1. Make sure that you are in Draft view by going to the View tab and clicking Draft.

1. On the References tab, in the Footnotes group, click Show Notes.

2. In the note pane list, click and choose the type of separator you want to change or remove.

a. To change the separator that appears between the document text and notes, click Footnote Separator or Endnote Separator.

b. To change the separator for notes that continue from the previous page, click Footnote Continuation Separator or Endnote Continuation Separator.

3. Select the separator and make changes:

· To remove the separator, press DELETE.

· To edit the separator, insert a Clip Art divider line or type text.

· To restore the default separator, click Reset.

Delete a footnote or an endnote

When you want to delete a note, you work with the note reference mark in the document window, not the text in the note.
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1. Note reference mark

If you delete an automatically numbered note reference mark, Word renumbers the notes in the new order.

DELETE A NOTE
· In the document, select the note reference mark of the footnote or endnote that you want to delete, and then press DELETE.

· Activity 12
· Open a saved document
· Insert footnotes
· Insert end notes
· Remove footnotes and end notes
· Save the document.
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